
SWRB PHD KNOWLEDGEBASE SOFTWARE 
TUTORIAL & USER GUIDE 

 
 
Welcome to this tutorial and user guide to the SWRB KnowledgeBase Software 
that comes with both the original USB-Based Puritan Hard Drive and the new 
On Demand Edition. We will note the few interface differences between the 
two editions of the software.  
 
In this tutorial, we will demonstrate both the power and ease of use of this 
critically acclaimed software. We will be using the Mac version of the 
KnowledgeBase software in this Tutorial. In every important aspect, the 
software is identical in appearance and functionality in the Mac and Windows 
versions. Any perceived differences are due to the way applications natively 
behave on the two different operating systems and the file extensions for 
application executables (see below). For example, on the Mac the application 
Main Menu appears on the top of the Mac display, whereas on Windows the 
application runs in its own dedicated window with the Main Menu at the top of 
that window. 
 

 
LAUNCHING THE  

PHD KNOWLEDGEBASE SOFTWARE 
 

MAC VERSION 
 

To launch the Mac version of PHD KnowledgeBase Software, double click on 
the application executable file “PHD KnowledgeBase Application.app 
(depending on your Finder settings, the extension “.app” may not be visible in 
the Finder files listings), which is located in the Puritan Hard Drive directory 
tree (Figure 1). 
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Figure	
  1:	
  PHD	
  KnowledgeBase	
  Application	
  Executable	
  in	
  PHD	
  Directory	
  Tree	
  (Mac	
  Version) 

 
WINDOWS VERSION 

 
To launch the Windows version of PHD KnowledgeBase Software, double click 
on the application executable file “PHD KnowledgeBase Application.exe 
(depending on your Windows Explorer settings, the extension “.exe” may not be 
visible in the Explorer files listings), which is located in the Puritan Hard Drive 
directory tree (Figure 2). 
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Figure	
  2:	
  PHD	
  KnowledgeBase	
  Application	
  Executable	
  in	
  PHD	
  Directory	
  Tree	
  (Windows	
  Version) 

 
 

MAIN MENU 
 
We’ll begin with a tour of the Main Menu, which appears when the PHD 
KnowledgeBase Application is launched. 
 
The File dropdown Menu (Figure 3) contains options for page setup for your 
printer, printing reports (resource details, lists, etc), backing up the current 
knowledgebase file, testing the connection to the PHD-ODE server from which 
resources are downloaded [PHD-ODE only], displaying the welcome window 
and finally safely exiting the application.  
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Figure	
  3	
  -­	
  Main	
  Menu:	
  File	
  Dropdown	
  Menu 

 
This last option will require confirmation that the user wants to end the 
program, giving the user the opportunity to save any changes made to the 
KnowledgeBase that haven’t already been saved. If the user exits the application 
using the “Quit PHD KnowledgeBase Application” on the system menu “PHD 
KnowledgeBase Application”, the program will terminate immediately without 
an opportunity to save work in progress. Always terminate the application using 
the Exit options to avoid corrupting the KnowledgeBase file. This includes 
allowing the computer to “sleep” while the KnowledgeBase application is still 
running.  
 
Every time the application is launched, it will automatically check the 
KnowledgeBase file to be sure it was not damaged by an improper shutdown. If 
the application finds the KnowledgeBase to be in an inconsistent state, it will 
attempt to restore it.  If a message displays indicating that the application is 
checking the file’s consistency, the operation should be allowed to run to 
completion without interruption. If the file cannot be restored, our support 
department should be contacted for further assistance.  
 
As with other software applications, the best insurance against data loss due to 
damaged or corrupted files is to periodically backup the changed file(s). The 
aforementioned backup option on the File dropdown menu can be used to save 
a copy of the current KnowledgeBase file. 
 
The Edit dropdown menu (Figure 4) contains options for editing notes and 
comments that the user may add to the KnowledgeBase. 
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Figure	
  4	
  -­	
  Main	
  Menu:	
  Edit	
  Dropdown	
  Menu 

 
The View dropdown menu (Figure 5) contains options to display detailed 
listings of the 12,500+ PHD resources, organized by media type. The last 
option will display a detailed listing of all the resources that have been 
downloaded and currently reside on the local hard drive [PHD-ODE only]. 
 

	
  
Figure	
  5	
  -­	
  Main	
  Menu:	
  View	
  Dropdown	
  Menu 

 
The Search dropdown menu (Figure 6) provides an option to initiate a new 
search of the KnowledgeBase. Many other system windows have a Search 
button as well. Clicking on that button in a Search Results window will allow the 
user to initiate a new search or search within the results already contained in 
the window, a process called “drilldown” that we’ll discuss in detail later in this 
tutorial. 
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Figure	
  6	
  -­	
  Search	
  Dropdown	
  Menu 

 
The Saved Search Results Sets dropdown menu (Figure 7) provides an option 
to display and manage a collection of all Search Results Sets that have been 
created and are currently stored in the KnowledgeBase. These sets allow the 
user to access Saved Search Results Sets in an efficient and easily manageable 
way. 
 
 

	
  
Figure	
  7	
  -­	
  Main	
  Menu:	
  Saved	
  Search	
  Results	
  Sets	
  Dropdown	
  Menu 

 
The Saved Search Results Set Lists dropdown menu (Figure 8) has an option to 
display and manage a collection of lists of Saved Search Results Sets. These lists 
allow the user to organize many Saved Search Results Sets in a meaningful 
manner. 
 
 

	
  
Figure	
  8	
  -­	
  Main	
  Menu:	
  Saved	
  Search	
  Results	
  Set	
  Lists	
  Dropdown	
  Menu 

 
The PDF Resource Sets dropdown menu option (Figure 9) provides an option 
to display a listing of pre-defined sets of PDF resources, organizing more than 
1,700 books and articles in 333 easily accessible sets. 
 
 

	
  
Figure	
  9	
  -­	
  Main	
  Menu:	
  PDF	
  Resource	
  Sets	
  Dropdown	
  Menu 

 
The Favorites List dropdown menu option (Figure 10) opens a Favorites List 
window that allows the user to manage the resources that have been added to 
this list. This list is used as a convenient place to reference resources that have 
been identified for future study. 
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Figure	
  10	
  -­	
  Main	
  Menu:	
  Favorites	
  List	
  Dropdown	
  Menu 

 
The Tutorial Videos and Software Updates dropdown menus (Figures 10 & 11) 
provide options to display in the default browser web pages on 
PuritanDownloads.com containing tutorial videos for viewing as well as 
information on the availability of updates for the KnowledgeBase software. 
 
 

	
  
Figure	
  11	
  -­	
  Main	
  Menu:	
  	
  Tutorial	
  Videos	
  Dropdown	
  Menu	
  

	
  

	
  
Figure	
  12	
  -­	
  Main	
  Menu:	
  Software	
  Updates	
  Dropdown	
  Menu	
  

 
The Glossary dropdown menu option (Figure 13) displays a tabbed window 
with short explanations of the key concepts of the SWRB KnowledgeBase 
application. 
 

	
  
Figure	
  13	
  -­	
  Main	
  Menu:	
  Glossary	
  Dropdown	
  Menu 
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PHD KNOWLEDGEBASE SOFTWARE 
ON THE PHD-ODE 

 
 
The essential difference between the original Puritan Hard Drive and the lower 
cost, more affordable Puritan Hard Drive – On Demand Edition is that the 
former comes delivered with 12,500+ resources and the KnowledgeBase 
software on a USB external hard drive and the latter is fully downloadable from 
the Internet. The PHD-ODE KnowledgeBase Software is downloaded as a 
single archive zip file (Mac version) or self-extracting archive executable 
(Windows version).  
 
Once the ultra-simple installation process is completed and the software 
installed on the user’s computer’s internal hard drive, external hard drive, or 
even on a flash drive attached to that computer, the PHD-ODE user can 
download from the PHD-ODE server individual resources as they are 
referenced in the locally stored KnowledgeBase, no matter where that user 
resides in the world. If the available free hard drive space is at a premium, 
unwanted resources can be deleted to make room for others. Deleted resources 
can always be re-downloaded at another time, if so desired. All downloaded 
resources are always accessible even when not connected to the Internet. 
 

PHD-ODE DOWNLOAD PROCESS 
 

Let’s see just how easy and seamless the download process really is. 
 
In this tutorial, we are using a newly installed PHD-ODE so no resources have 
yet been downloaded. If we go to the View dropdown menu discussed 
previously and click on the “All Downloaded Resources List”, an empty listing 
window will be displayed and a message dialog box will appear informing us 
that "There are no currently downloaded resources" (Figure 14). 
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Figure	
  14	
  -­	
  Empty	
  Downloaded	
  Resources	
  List 

 
We’ll return to the View dropdown menu and select the option “All Searchable 
Books/Articles (PDF) List” (Figure 15). We will go to a listed resource and 
attempt to open it in our default PDF application. According to the 
information shown in the File Details section of the tabbed panel, the resource 
is not on the drive. The label “On Hard Drive” displays a “No”. To the right of 
this label is a light orange button with the somewhat faded text that reads 
“Delete This Resource From the Hard Drive”. This button is currently 
disabled because the resource doesn’t reside on the hard drive. 
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Figure	
  15	
  -­	
  PHD-­ODE	
  Interface	
  Elements 

 
When we click on the “Open Resource” checkmark button the software will 
double-check if the resource is currently stored on the hard drive. Since it 
doesn’t find the resource, it immediately connects to the PHD-ODE server and 
initiates the download process.  
 
A dialog box with a progress bar appears and displays a visual representation of 
the downloading activity (Figure 16) . In just a few moments, the download is 
finished and the resource appears in the default PDF application. The duration 
of the download process will depend on the speed of your Internet connection, 
the size of the resource file and the current volume of traffic on the Internet. 
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Figure	
  16	
  -­	
  PHD-­ODE	
  Downloading	
  Resource 

 
If we look again at the File Details panel we should notice two changes have 
occurred (Figure 17). The “On Hard Drive” label now displays “Yes”, 
indicating that the resource has been successfully downloaded and stored in the 
PDF folder in the Puritan Hard Drive directory tree. Additionally, the 
previously orange colored “Delete” button has changed to a blue color and its 
text is displayed in bright white. Clicking on this button will delete the resource 
from the hard drive, but as mentioned earlier, the resource can always be re-
downloaded when the user desires. 
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Figure	
  17	
  -­	
  Interface	
  Changes	
  After	
  Downloading	
  Resource 

 
If we return to the Main Menu and select from the View dropdown menu the 
option “All Downloaded Resources List” (Figure 18), we now see that the 
resource we have just downloaded has been added. The list provides an easy 
way to view in one place all downloaded resources that are currently stored on 
the local hard drive. 
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Figure	
  18	
  -­	
  Updated	
  Downloaded	
  Resources	
  List 

 
And that is all there is to downloading resources from the PHD-ODE server. As 
long as there is an active Internet connection available, the user is only a click 
away from accessing the 12,500+ resources in the Puritan Hard Drive 
collection. 
 
 

THE SEARCH PROCESS 
 
 
As noted above, the Puritan Hard Drive is a massive collection of more than 
12,500 PDF, MP3 and WMV resources. Search is the principal process used to 
locate resources of interest to the user. To initiate a “New Search”, we can click 
on the “New Search” dropdown menu option and click on the “Start New 
Search” option.  
 
A dedicated Search window (Figure 19) will open to facilitate locating resources 
based on a variety of resource attributes such as Author, Title, Category, 
Description, Media Type, and so forth. This default search panel allows the 
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user to enter one or more attributes to be matched simultaneously. When 
entering multiple search attributes in a single query, a particular resource must 
match ALL the attributes entered in order for that resource to be returned in 
the Search Results Set. Accordingly, we recommend that the user only enter 
multiple attributes when looking for a very specific resource with a fair amount 
of confidence that all the attributes entered are correct. Because the user has the 
ability to “drilldown” or refine the search results through subsequent queries 
against the previous returned search results set, it is not necessary, indeed it is 
often counter-productive, to use multiple attributes in a single query. 
 

	
  
Figure	
  19	
  -­	
  Search	
  KnowledgeBase	
  Window 

 
 
The following example will illustrate how to use this powerful search 
functionality to achieve the best possible results. 
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Suppose the user is interested in finding resources in the category “Calvinism 
and The Sovereignty of God”. Going to the already opened “Search 
KnowledgeBase” tabbed panel window, click on the “Select Category from List” 
button to display the “Select Category for Search” dropdown list (Figure 20). 
Click on the category title “Calvinism and The Sovereignty of God”. The 
category list will close and the selected category will be entered in the search 
panel. If we had wanted only those resources in this topic by a particular author, 
we could have clicked on the “Select Author from List” button to choose the 
author we are interested in. This would have returned a search results set with 
only those resources, if any, that matched both the author name and the selected 
category topic. But since we are interested in first looking at all the resources in 
this category, we have not included an author’s name in this initial query. 
 

15 
 

© Still Waters Revival Books, 2012 



	
  
Figure	
  20	
  -­	
  Select	
  Category	
  for	
  Search	
  Window 
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We will now click on the Search button to initiate our query. Virtually 
instantaneously, a Search Results window (Figure 21) will appear with a listing 
of 1,840 resources, in alphabetical order by the resource author’s last name. 
Since this is probably the most often used window in the KnowledgeBase 
application, let’s take a closer look at the information and functionality 
provided here. 
 

 
Figure	
  21	
  -­	
  Search	
  Results	
  Window 
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SEARCH RESULTS WINDOW 

 
 
The Search Results window is divided into two main sections. The top section 
(Figure 22) contains a set of buttons providing access to the following 
functionality:  
 

• “Print”: print a listing of all the resources in this Search Results window 
• “Display All”: add all resources in the PHD collection to this listing 
• “Details View”:  open a  “Resource Details” window for all resources in 

the Search Results window (more on the “Resource Details” view further 
on in this tutorial) 

• “Search”: initiate a new search of either the entire KnowledgeBase or just 
the subset of the KnowledgeBase contained in this Search Results Set 

• “Save”: save this set of results for further research 
• “Close”: close this Search Results window 

 
 

	
  
Figure	
  22	
  -­	
  Search	
  Results	
  Window	
  -­	
  Top	
  Section 

	
  
To the right of these buttons is a monitor icon with a question mark in the 
center. Clicking on this button will open in the default browser a section of the 
PuritanDownloads.com website with tutorial videos on using the PHD 
software. 
 
The next item in this row displays the number of resources in this listing.  
 
At the end of the row is a navigation button set. Clicking on the buttons with 
arrows will move the row marker (a thin black line at the very beginning of the 
resource listing row) to the next or previous resource. The button with the left 
pointing arrow moves the row marker up one resource towards the top of the 
listing. The button with the right pointing arrow moves the row marker down 
one resource towards the bottom of the listing. When a listing contains 
hundreds or even thousands of resources, the navigation button set provides a 
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helpful numerical representation of where in the results set the resources 
currently displayed are situated. 
 
Above these buttons is a row of three buttons corresponding to the media types 
included in the PHD resource collection. This allows the user to exclude a 
particular type of media, for example, audio MP3 resources, from this Search 
Results window. Selecting a particular Media Type in the original query would 
have returned only matching resources of the designated type. 
 
Let’s take a look at what’s presented in the other main section of the Search 
Results window (Figures 23 - 25). This section displays the listing of resources 
returned by the last query. Moving from left to right, we see a set of vertically 
arranged buttons under the heading, “Actions”. The top button has a white 
checkmark within a green circle. This is the “Open Resource” button. Clicking 
on this button will open the resource in its appropriate reader/player depending 
on the resource media type.  
 

	
  
Figure	
  23	
  -­	
  Search	
  Results	
  Window	
  Bottom	
  Section	
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Figure	
  24	
  -­	
  Search	
  Results	
  Window:	
  Open	
  Resource	
  Button 

 

	
  
Figure	
  25	
  -­	
  Resource	
  Displayed	
  in	
  Default	
  PDF	
  Application 

 
In the PHD-ODE, if the resource is not present on the local hard drive in its 
pre-defined folder and the computer has an active Internet connection, the 
software will contact the PHD-ODE server and commence the downloading 
process. In a few moments, depending on the speed of the Internet connection, 
the volume of traffic on the Internet and the size of the resource file, the 
resource will be downloaded and stored on the local hard drive. The resource 
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will then appear in the appropriate reader/player. On the original Puritan Hard 
Drive, which is delivered with all the resources in the PHD collection, the 
resource will immediately appear. 
 
 

SEARCH PROCESS IN ACTION 
 

[The following text describes this operation in real time using the PHD-ODE 
software.  You can watch this in the accompanying tutorial video.] 
 
We’ll scroll down to the PDF resource listing for “The Voice of Renwick, The 
Last of the Scottish Martyrs (1882)” by William Anderson. It is a relatively 
small file – 2.75MB – so the download should complete in a matter of seconds. 
If we take a glance at the tabbed panel at the far right of the window (we’ll look 
at that panel in detail shortly), we see that the field “On Hard Drive” has a “No” 
entry, indicating that at the time the KnowledgeBase was last updated, the 
resource did not reside in it’s assigned location on the local hard drive. Since 
the software cannot prevent a user from manually deleting a file from the disk 
or copying a resource to the disk (a practice we strongly discourage the user 
from engaging in), the software will always check to see if in fact the file exists 
despite what information is in the KnowledgeBase.  If the software finds the 
appropriate file, it will update the KnowledgeBase accordingly and launch the 
appropriate reader/player application. If the file is not found, it will download it 
from the PHD-ODE server and update the KnowledgeBase upon completion of 
a successful download.  
 
We have implemented this checking/updating routine to not only make sure 
that the information in the KnowledgeBase accurately reflects the state of the 
PHD installation, but also to facilitate copying the KnowledgeBase file to 
another installation where the collection of resources do not exactly match the 
collection on the original computer. As the copied KnowledgeBase file is used 
on the second computer, the KnowledgeBase will update itself when the out of 
sync resource is accessed, thus over time the KnowledgeBase will be updated to 
accurately reflect the storage of all downloaded resources. 
 
We’ll click on the “Open Resource” button and a progress dialog box appears 
that displays a visual representation with a percentage completion of the 
download process. When the process is completed, the PDF appears in the 
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default PDF application. We’ll close the PDF reader and check the tabbed 
panel. The value in the field “On Hard Drive” has been changed to “Yes” and 
the “Delete This Resource From the Hard Drive” button has been changed to 
dark blue and is now enabled. Clicking on the button will display a 
confirmation dialog box where we can confirm deleting the resource from the 
hard drive. It also reminds us that we can re-download the resource file at a 
future time whenever required. 
 
Now we click on the “Open Resource” icon at the far left of the open window, 
the resource will be immediately displayed in the PDF reader since the file now 
resides locally on the hard drive. This process of downloading a resource from 
the PHD-ODE server and the related fields on the tabbed panel are the only 
factors that distinguish the workflow of the PHD-ODE software from that of 
the original PHD software that is distributed on a USB external hard drive. 
 
Below the “Open Resource” button is the “Delete Resource” button (a red 
cross mark) (Figure 26). This deletes the resource from the Search Results 
listing but does not remove the resource from the hard drive. 
 

	
  
Figure	
  26	
  -­	
  Search	
  Results	
  Window	
  -­	
  Delete	
  Resource	
  From	
  Listing	
  Button 

 
The next column after the “Action” buttons displays the resource title and 
author (Figure 27). Upon initial opening, the Search Results window will 
present the resource listings in alphabetical order by author  (last name, first 
name). In the event there are multiple resources by the same author, the 
resources will be listed alphabetically by title within the author grouping. Some 
times the title display will be truncated because of the long length of the original 
title. In those instances, an ellipsis (“…” will appear at the end of the title. To 
view the title in its entirety, move the mouse cursor on the title and allow it to 
remain for a second or two, the full title will appear in a floating “tooltip” 
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window that will remain visible for approximately 10 seconds or will close when 
the mouse is moved. 
 

	
  
Figure	
  27	
  -­	
  Search	
  Results	
  Window	
  -­Title/Author	
  Column 

 
 

In the header row at the top of the column, there are two labels, “Title” and 
“Author”. Immediately to the left of each label is a small icon, consisting of the 
letters “A” and Z” with a down arrow. To the right of each label is a similar icon 
with a down arrow. When clicked, the former set of icons will sort the author 
and title listings in ascending alphabetical order (i.e., A – Z); the latter set of 
icons will sort the listings in descending alphabetical order (i.e., Z – A). 
 
Now let’s examine the vast amount of information contained in the tabbed 
panel (Figure 28), located to the right of the Author/Title column.  It should be 
noted that this panel appears in every listing window, not just on the Search 
Results window now displayed. 
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Figure	
  28	
  -­	
  Tabbed	
  Panel:	
  File	
  Details 

 
When first displayed, the tabbed panel will reveal the “File Details” tab’s 
associated fields. Exactly which fields will have values will depend on the 
resource’s media type. PDFs will have “Pages” values; MP3s and WMVs will 
display “Duration” (i.e., playing time) values. The column headers at the top of 
the listing section will allow the user to sort the resources by media type as well 
as “Pages” and “Duration”.  The same icons described before will allow the 
user to sort the listings in ascending/descending order by Media Type (PDF, 
MP3, WMV) or numerical order by the number of pages (PDFs) or the number 
of minutes of playing time. 
 
The fields in the “Files Details” tab contain the name of the resource file as 
stored on the hard drive, the Media type, number of pages, and resource file 
size. The status field will contain one of two possible values. “Commercial” 
signifies a resource that cannot be distributed without the express written 
consent of Still Waters Revival Books. The second value, “Free”, indicates that 
the resource may be freely distributed to others so long as the copyright 
restrictions of the resource’s original publisher are respected (for example, the 
resource is not modified in any way with respect to either content or 
authorship). 
 
The next field, “Duration”, is the playing time of the MP3 (audio) or WMV 
(video) resource, expressed in minutes. The “Resource Last Accessed” field 
records the date when the resource was last displayed by its respective 
reader/player application. The “On Hard Drive” field, discussed previously, 
indicates with a “Yes” or “No” whether the resource is currently stored on the 
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local storage device [PHD-ODE only]. The “Added to Favorites List” records 
the date the resource was added to the user’s Favorites List. The last field on the 
“File Details” tab indicates with a “Yes” or “No” whether the resource has been 
designated by the user for future downloading.  
 
The button to the right of this field allows the user to delete the downloaded 
resource file from the local hard drive [PHD-ODE only]. It will appear with a 
light orange background and very light text when the resource is not currently 
available on the hard drive. In this state the button is disabled and clicking on it 
will not have any action associated with it. If the resource file has been 
downloaded and resides on the hard drive, the button will have a dark blue 
background with bright white text. Clicking on the button in this state will 
delete the resource file from the hard drive after the user confirms the intent to 
proceed with the deletion.  As mentioned earlier, any resource so deleted may 
be re-downloaded as required by the user. After deletion, the button will revert 
to its orange, disabled state. 
 
The second tab, “Description” (Figure 29), will contain information about the 
content of the resource, ranging from a couple of sentences to several pages in 
length.  
 

	
  
Figure	
  29	
  -­	
  Tabbed	
  Panel:	
  Description 

 
The third tab, “Keywords” (Figure 30), contains a listing of keywords and 
phrases found in the resource, together with page references to the resources. It 
should be noted that these page references relate to the page numbers displayed 

25 
 

© Still Waters Revival Books, 2012 



by the PDF reader and not necessarily to the page numbers in the PDF 
document itself.  
 

	
  
Figure	
  30:	
  	
  Tabbed	
  Panel:	
  Keywords 

 
Also, when scrolling the listing screen, it is best not to have this tab open; 
otherwise there will be degradation in scrolling performance.  
 
Keywords will only appear when the resource has been rendered searchable 
through applying Optical Character Recognition (OCR) software to the PDF 
book or article. These keywords are derived from a list of more than 5000 
relevant words and phrases. The keywords have also been collected into an 
index with page references and appended to the book. In many instances, this is 
the first time in the history of the publication that it has had an index associated 
with it. In the tabbed Search KnowledgeBase panel, the user can search for 
resources based on the list of 5000 keywords and phrases. 
 
The fourth tab, “Categories” (Figure 31), displays a listing of all the categories 
assigned to the resource. Nearly 80 categories have been defined in the 
software. If the user is interested in seeing a listing of all the resources in a 
particular category, the category name can be clicked and a new window will 
appear showing all the associated resources. This illustrates a powerful feature 
of the interface design of the PHD KnowledgeBase software: virtually every 
window will give the user access to most of the functionality built into the 
software. 
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Figure	
  31	
  -­	
  Tabbed	
  Panel:	
  Categories 

 
The fifth tab, “Matching RCS” (Figure 32), displays a listing of the resources 
“Matching Resource Category Signature.” A later section of this tutorial will 
examine in depth exactly what the RCS is and how this unique feature can 
reveal interesting, previously hidden, relationships among the resources in the 
PHD collection. A button, “View Matching RCS Resources”, allows the user to 
open a Search Results windows containing all associated RCS resources, which 
can then be saved or used as the basis for further exploration of the 
KnowledgeBase. 
 

	
  
Figure	
  32	
  -­	
  Tabbed	
  Panel:	
  Matching	
  Resource	
  Category	
  Signature 

 
The sixth tab, “Results Sets” (Figure 33), will contain a listing of Saved Search 
Results Sets containing this resource. A Saved Search Results Set can be created 
when the user wants to preserve the results of a particular query or series of 
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queries of the KnowledgeBase. We will examine that process later on in this 
tutorial. Clicking on the name of the Saved Search Results Set will open a 
window with a listing of all the resources in that set. Since these sets are created 
by the user, the initial installation will not contain any sets and the listing here 
will be empty. A button, “View All Saved Search Results Sets”, allows the user to 
open window displaying all the Saved Search Results Sets” currently defined in 
the KnowledgeBase. 
 

	
  
Figure	
  33	
  -­	
  Tabbed	
  Panel:	
  Saved	
  Search	
  Results	
  Sets 

 
The seventh tab, “Results Sets Lists” (Figure 34), will contain a listing of any 
Saved Results Set Lists that the user has created. A Saved Search Results Sets 
List provides the user a way to organize into meaningful collections the 
potentially numerous Saved Search Results Sets that have been created over 
time. As with the previous tab, this listing will initially be empty. There is a 
button below the listing that allows the user to open a Saved Search Results Set 
Lists window that displays all the Lists that are currently defined in the 
KnowledgeBase. 
 

28 
 

© Still Waters Revival Books, 2012 



	
  
Figure	
  34	
  -­	
  Tabbed	
  Panel:	
  Saved	
  Search	
  Results	
  Sets	
  Lists 

 
The last tab, “Notes” (Figure 35), displays any notes that the user has attached 
to this resource. This is a read-only window. Notes can be created and edited 
using the Resource Details window to be discussed later. 
 

	
  
Figure	
  35	
  -­	
  Tabbed	
  Panel:	
  Notes 

 
Now that we’ve reviewed all the interface elements in the Search Results 
window, we can turn to an in-depth examination of the search process itself. 
Let’s return to the tabbed Search KnowledgeBase window to begin. 
 
This search window is accessible in one of two ways: the “New Search” option 
on the Main Menu or the “Search” button on a Search Results window. The 
“New Search” option initiates a brand new search, independent of any other 
windows that are currently open.  The “Search” button on a Search Results 
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window will provide the user with three distinct ways to apply the results of a 
search query: “New”, “Add” or “Limit” (Figure 36).  The “New” option will 
remove the existing results set and create a new set with all the resources that 
match the query. The “Add” option will take the results of the new query and 
add them to the existing Search Results sets, discarding any duplicates. 
 
The “Limit” option performs a “drilldown” operation against the existing 
results set. This means that instead of searching the entire KnowledgeBase using 
the entered query criteria, the query is applied to a subset of the KnowledgeBase 
consisting of the resources present in the current results set. This allows the 
user to successively refine the search process by the serial application of 
individual search criteria.  
 

	
  
Figure	
  36	
  -­	
  Search	
  Options 

 
This is an extremely powerful capability when dealing with search results that 
may include thousands of resources. At any time in the search process, the user 
may preserve the results of a query or set of queries by creating a Saved Search 
Results Set and giving that set a unique name.  The user is advised to make 
frequent use of this capability because a “Limit” operation that fails to return 
any results will cause the Search Results Set to be emptied and the Search 
Results window will be closed.  
 
Once created, the Saved Search Results set cannot be changed, though it may be 
renamed or deleted. Moreover, by clicking on the “Search Results View” button 
on the Saved Search Results Set window, the existing set may be instantaneously 
converted into a new Search Results set which can then serve as the basis for 
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additional queries. This is a non-destructive conversion since the original Saved 
Search Results remains unaltered and preserved for future use  
 
Let’s see how this search process works in real time. We’ll begin by initiating a 
new search by clicking on the “New Search” option on the Main Menu.  
 
For the purpose of this demonstration, we’ll be looking for all the resources by 
the author Thomas Boston. We’ll click on the “Select Author from List” button 
and bring up a listing of all resource authors (Figure 37). 
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Figure	
  37	
  -­	
  Search	
  KnowledgeBase	
  Panel:	
  Select	
  Author	
  from	
  List	
  Popup	
  Window 

 
A row of buttons at the top of this window allows us to select the first letter of 
the author’s last name. This is an expedited way of finding the author from the 
almost 800 authors included in the PHD collection. We click on the “B” button 
and then click on the name “Boston, Thomas”. The author’s name is now 
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entered in the Author field on the tabbed search panel (Figure 38). If we had so 
desired, we could have entered the name directly in the Author field. Since 
there are a number of authors whose names have variant spellings, it is often 
useful to use the author selection list to ensure that the search query will be 
successful. 
 
At this point we could enter other information about Boston’s work into the 
search window. However, as noted earlier, if any additional information is 
entered, all of it must match in order for a resource to be returned in the search 
results. We recommend entering as little information as possible in the initial 
query in order to make sure that the maximum number of relevant resources 
will be found. We can always enter subsequent queries against the initial search 
results to zero in on the particular resource or resources we’re interested in. 
Moreover, by scrolling through the initial results we might find other resources 
of interest that would otherwise not be included by a more exclusive search 
query. 
 
We’ll now execute the query by clicking on the “Search” button at the bottom 
right-hand side of the tabbed search panel.  
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Figure	
  38	
  -­	
  Search	
  Knowledge	
  Panel:	
  Search	
  by	
  Author 
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In a matter of seconds, the Search Results window is displayed containing 72 
resources (Figure 39).  
 

	
  
Figure	
  39	
  -­	
  Search	
  Results	
  Window	
  for	
  "Boston"	
  Author	
  Search 

 
As we scroll down this listing, we see that a number of resources are MP3 
versions of Boston’s works. Since we are only interested in Boston’s works in 
PDF book format, we can click on the “MP3” button at the top of the Search 
Results window to exclude MP3s from the resource listing. A dialog box (Figure 
40) appears informing us that 27 MP3 resources have been excluded from our 
listing, leaving 45 PDF and possibly WMV video resources as well. Clicking on 
the “WMV” exclusion button reveals that there were no WMVs included in the 
search results. We are now left with 45 PDF resources in our listing.  
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Figure	
  40	
  -­	
  Search	
  Results	
  Window:	
  MP3s	
  Excluded	
  from	
  Results	
  Listing 

 
If we now click on the “Categories” tab in the tabbed panel on the right hand 
side of the screen (Figure 41), the categories assigned to each resource is 
displayed. Again, for the purpose of this demonstration, we determine that the 
category, “Sanctification, Prayer and Holiness” is of interest to us and we would 
like to limit the listing to those resources that have been assigned that category.  
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Figure	
  41	
  	
  -­	
  Search	
  Results	
  Window	
  with	
  Categories	
  Displayed 

 
We can accomplish this goal by clicking on the “Search” button at the top of the 
Search Results window to apply a category search to these resources. We’ll click 
on the “Select Category from List” button to bring up a list of all categories 
defined in the KnowledgeBase. We’ll click on the “Sanctification, Prayer and 
Holiness” category name and the Category field will be populated with it. When 
we click on the “Search” button, a dialog box will appear with three buttons to 
direct the software how and where to apply the results of the category search. 
Since we want to apply the query against the results contained in the Search 
Results window and limit those results to resources containing the selected 
category, we will click on the “Limit” button. We now see that 15 resources 
have been removed the results, leaving 30 resources.  
 
 
 
We’re also interested in another category, “Salvation and Evangelism”. We’ll 
repeat the process we’ve just completed, but this time choosing the category 
“Salvation and Evangelism” from the category list. As a result of this additional 
drilldown query, we now have 23 fewer resources in our listing. If we click on 
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the “Categories” tab in the tabbed panel (Figure 42), we can see that all of the 
seven remaining resources has at least “Salvation and “Evangelism” and 
“Sanctification, Prayer and Holiness” assigned to its list of associated 
categories. 
 

	
  
Figure	
  42	
  -­	
  Search	
  Results	
  After	
  Drilldown 

 
This is a much more manageable number of resources to examine individually 
than the number with which we first started. If we wanted to, however, we could 
apply this limiting or “drilldown” technique to narrow this listing even further. 
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RESOURCE DETAILS WINDOW (PART 1) 
 
 
Now that we have a listing of works of interest, we can examine each of them in 
greater detail. This is most effectively done by opening up the Resource Details 
window for each work. This can be accomplished in two ways. We can click on 
the book cover graphic for each individual resource or, if we intend to examine 
all of them, we can click on the button “Details View” at the top part of the 
Search Results window and examine each of the resources serially (Figure 43). 
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Figure	
  43	
  -­	
  Resource	
  Details	
  Window	
  for	
  7	
  Resources 

 
Choosing the latter function, we click on the “Details View” button and a 
Resource Details window opens for the first resource in the listing. What 
distinguishes this Resource Details window from the Resource Details window 
opened by clicking on the book cover graphic in the Search Results window is 
the ability to cycle through all of the Resource Details windows for all the 
resources in our listing. We can do this by using the navigational buttons in the 
upper right-hand side of the window.  We see here that there are 7 Resource 
Detail windows linked to the current window. Clicking on the right arrow 
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button will display the next Resource Details window in the list. Clicking on the 
left arrow button will display the previous Resource Details window. 
 
Although much of the information displayed in this window is also available in 
the Search Results window, the Resource Details window gives us access to 
more functionality. We’ll concentrate on this additional functionality. 
 
The next to last tab on the top tabbed panel  (Figure 44) allows us to add notes 
on this resource which can be copied and pasted, for example, in a research 
paper being written in a word processing program. These notes then can be 
displayed wherever the resource appears in a listing throughout the software. 
We can also use the tabbed Search KnowledgeBase window to search for text in 
the notes throughout the KnowledgeBase.  
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Figure	
  44	
  -­	
  Resource	
  Details	
  Window:	
  Notes	
  and	
  My	
  Comments	
  Tabs 

 
The last tab allows us to write comments on the resource and send them, if we 
so desire, via the default mail client on the local computer to SWRB for possible 
inclusion in commentary on this resource’s web page on 
PuritanDownloads.com.  Buttons are available at the bottom of the text box to 
append comments to the notes and vice versa. 
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Let’s now click on the Details tab to return to the state of the Resource Details 
window when it first opened (Figure 45). Here we see that there is a sub-panel 
that also contains additional functionality. At the top of the sub-panel is a row of 
three buttons. The first button allows the user to open a new Search Results 
window populated with a listing of the resources whose category signatures 
match this resource. This window could then be used as the starting point for a 
further exploration of the PHD KnowledgeBase and its vast collection of 
resources. 
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Figure	
  45	
  -­	
  Resource	
  Details	
  Windows:	
  Display	
  Resources	
  Matching	
  Category	
  Signature	
  Button 

 
 

RESOURCE CATEGORY SIGNATURE (RCS) 
 
This is an appropriate point in this tutorial to describe Resource Category 
Signature functionality that is unique to the PHD KnowledgeBase software. 
 
Every Resource in the Puritan Hard Drive collection has been classified by one 
or more (up to 25) categories. This set of categories for a resource is referred to 
as its Resource Category Signature (RCS). Resources that share the same RCS 
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are considered to be the most similar in subject content. For one resource to be 
a matching RCS resource of another, it must have all of the latter's categories 
contained in its RCS, though it may have other Categories associated with it as 
well. For example, for resource "A" to be considered to be a Matching RCS 
resource of resource "B", it must have all of resource "B" Categories associated 
with it, though again, it may have other categories as well. More than 90% of 
the resources have Matching RCS resources. It is useful to note that the more 
categories a resource has, the less likely it will have many or any Matching RCS 
resources. Using the RCS functionality in the PHD KnowledgeBase resource 
will often reveal hidden content similarities among the thousands of resources, 
including audio (MP3) and video (WMV) resources, contained in the PHD 
collection. Even those users with an extensive familiarity with many of these 
Puritan and Reformation works have remarked that they have discovered 
similarities among resources that they have never considered before using the 
RCS functionality of the PHD KnowledgeBase software. 
 
To view a Resource's Matching RCS Resources, simply click on the tab panel 
"Matching RCS" anywhere the Resource is listed or on the tab panel 
"Resources Matching Category Signature" on the Resource Details window. 
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RESOURCE DETAILS WINDOW (PART 2) 

 
Let’s return now to the second and third buttons on the “Details” sub-panel on 
the Resource Details window (Figure 46). 
 
These two buttons allow the user to add the resource to, or remove the resource 
from, the Favorites List. 
 

	
  
Figure	
  46	
  -­	
  Resource	
  Details	
  Window:	
  Add	
  to	
  Favorites	
  List 
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It may sometimes be useful to identify a particular resource for future study. 
For this purpose there is a "Favorites List" (Figure 47) to which these resources 
may be easily added, removed or accessed as desired. To add a resource to this 
List, simply click on the button "Add this Resource to Favorites List" located 
on the Resource's Resource Details screen. The date this resource was added to 
the List will be recorded and displayed wherever the resource is displayed in 
any listings. To remove this resource from the List, you can either click on the 
button "Delete this Resource from Favorites List" on the resource's Resource 
Details screen or click on the cross mark located beside the resource listing in 
the Favorites List itself. 
 

	
  
Figure	
  47	
  -­	
  Favorites	
  List 

 
Lastly, the Resource Details window contains a “Print Details” button that 
allows the user to generate and print a report containing the most important 
details about this resource. 
 
We’ll close the Resource Details window and return to the Search Results set. 
One of the most important aspects to keep in mind about the Search Results 
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window is its temporary nature. If we close the Search Results window without 
first saving it, we will need to re-query the database to re-create this set. 
 
If we anticipate creating multiple sets containing a categorized listing of 
Boston’s works, we can create a Saved Search Results Set List to store 
references to such sets. This list can be created by either clicking on the “Lists” 
button on the Saved Search Results Set window or on the Saved Search Results 
Set List option on the Main Menu. Using either method will display a Saved 
Search Results Set Lists window displaying all currently existing lists. If none 
exists, a dialog box will appear prompting the user to create one.  
 
 

SAVED SEARCH RESULTS SET WINDOW 
 
As previously mentioned, if we want to preserve this search results set for 
further use, we need only click on the “Save” button at this time and give it an 
appropriate name, for example, “Boston’s Works on Salvation, Sanctification 
and Prayer”. This name will appear as the title of the set’s window. We now 
have a Saved Search Results Set  (Figure 48) that we can access whenever the 
need arises.  
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Figure	
  48	
  -­	
  Saved	
  Search	
  Results	
  Set	
  Window 
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Let’s examine what information and functionality is available on this window. 
As with many other windows in the PHD KnowledgeBase software, there is a 
row of buttons in the top section of the window: 
 

• “Print”:  allows the user to print a report listing the resources in this set. 
• “Search Results View”: will non-destructively convert the window into a 

Search Results window that can be used as the basis for further searches 
of the KnowledgeBase.  

• “Details View”:  non-destructively creates a serial Resource Details 
window that provides additional functionality to examine each of the 
resources contained in the Saved Search Results Set.  

• “Lists”: will open the Saved Search Results Set Lists window.  
• “Sets”: will open the Saved Search Results Sets window, displaying all the 

sets that are currently available in the KnowledgeBase.  
• “Notes”, will open an edit window that allows the user to add and/or edit 

existing notes for this set.  
• “Delete” and “Rename”:  will allow the user to either delete or rename 

this set. Once created, the set cannot be edited but can be renamed or 
deleted from the KnowledgeBase.  

• “Close”, will close this window.  Only one copy of the window can be 
displayed at any time.  

 
To the right of these buttons is a monitor icon that when clicked will open the 
default browser to a page on PuritanDownloads.com that contains PHD 
KnowledgeBase software tutorial videos. To the right of the monitor icon is a 
field that displays the number of resources in this set. Directly above these last 
two interface elements is a set of navigation buttons that when clicked will move 
the row marker either forward or backward in the resource listing. 
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SAVED SEARCH RESULTS SETS WINDOW 

 
Let’s now examine what functionality the Saved Search Results Sets window 
contains (Figure 49). 
 

	
  
Figure	
  49	
  -­	
  Saved	
  Search	
  Results	
  Sets	
  Window 

 
Clicking on the “Saved Search Results Sets” option on the Main Menu will 
display the Sets window if such sets are currently defined in the KnowledgeBase. 
 
In the top section of the window is a button, “Lists”, that opens (or brings to the 
front if already opened) a “Saved Search Results Set Lists” window. This is 
helpful if the user intends to add the set to a pre-existent List or wishes to create 
a new List for the same purpose. The next button, “Close”, will close this 
window. Only one copy of this window can be opened at any time. To the right 
of these two buttons is the monitor icon to access tutorial videos on the 
PuritanDownload.com website. The field to the right of this icon displays the 
number of sets current defined in the KnowledgeBase. To the right of this field 
is a set of navigation buttons that allows the user to move the row marker one 
set at a time either forward or backward.  
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The first column in the second section of the window has a set of “Actions” 
buttons. Clicking on the green plus-sign icon will display a popup window with 
the names of defined Saved Search Results Set Lists to which this set can be 
added. Clicking on the next lower button with a page and green plus-sign icon 
will allow the user to add and/or edit notes attached to this set. The next button 
with a page and pencil icon will allow the user to rename the set. The fourth 
button, a printer icon, prints a report listing all the resources in this set. The last 
button, a red cross mark, will allow the user to delete this set from the 
KnowledgeBase. 
 
The second column displays the name of the set. Clicking on the name will 
open a Saved Search Results Set window displaying all the resources assigned to 
the set. The third column has a tabbed panel. The first tab displays all the Lists 
to which the set has been assigned. To the left of the list name is a button with a 
minus sign in a red circle. Clicking on this button will allow, after confirmation, 
the user to delete the list assignment. The second tab, “Resources in Set”, 
displays a listing of all resources in the set. Clicking on the resource name will 
open a Resource Details window for that particular resource. The last tab 
displays any notes that have been attached to the set. This is a read-only display. 
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SAVED SEARCH RESULTS SET LISTS WINDOW 

 
 
Let’s now examine what functionality the “Saved Search Results Set Lists” 
window contains (Figure 50). 
 

	
  
Figure	
  50	
  -­	
  Saved	
  Search	
  Results	
  Sets	
  Lists	
  Window 

 
Clicking on the “Saved Search Results Set Lists” option on the Main Menu will 
display the Lists window (or will bring it to the front if already opened) if there 
are currently such lists defined in the KnowledgeBase. If none exist, a dialog box 
will appear and give the user the opportunity to create and name one. There are 
no practical limits to the number of lists that can be created (subject to available 
disk space). These lists can be created at any time, irrespective of whether there 
are existing Saved Search Results Sets available to populate those lists. 

53 
 

© Still Waters Revival Books, 2012 



 
A row of buttons at the top of the lists window offers the following functionality: 

• “New”: will allow the user to create a new list.  
• “Sets”: will open a Saved Search Results Sets window listing all of the 

currently defined Saved Search Results window. This allows the user to 
examine the sets before possibly adding them to one or more lists. Any 
individual Saved Search Results Set may be added to an unlimited 
number of lists.  

• “Close”:  closes the window. There can only be one copy of the Saved 
Search Results Set Lists window open at a time. This is true of the Saved 
Search Results Sets window as well.  

The remainder of the interface elements in this top section should be familiar 
by now: a monitor icon for accessing tutorial videos on 
PuritanDownloads.com; a field which shows how many lists are available; and, 
lastly, a set of navigation buttons to move the row marker one list at a time 
forward or backward. 
 
In the first column of the lower section of the window we see a set of “Actions” 
buttons.  Clicking on the green plus sign button, displays a popup list of defined 
Saved Search Results Sets that can be added to the list in the current row.  
Clicking on the name of the set will add it to the target list. The next lower 
button, a page with a plus sign icon, will allow the user to add or edit notes 
attached to this list. This is a handy place to define the list’s purpose or any 
other relevant information. The next icon provides the capability of renaming 
the list. The last button, a cross mark or “X”, allows the user to delete the list. 
 
The next column displays the list’s name.  
 
The last column contains a tabbed panel that displays the names of the Saved 
Search Results Sets assigned to the list. To the left of the name is a button with a 
minus sign in a red circle. Clicking on this button will, after confirmation, 
delete the set from the list. Clicking on the name of the set will display, in a 
separate window, the resources contained in the set. 
 
The second tab on the panel will show the notes that have been attached to the 
list. This is a read-only display. 
 

54 
 

© Still Waters Revival Books, 2012 



 
PDF RESOURCE SETS WINDOW 

 
For the user’s browsing convenience, we have organized more than 1,700 PDF 
resources into related sets (Figure 51). The sets represent either all the pre-
defined volumes of a particular work (i.e., The Works of Thomas Manton - 22 
Volumes) or a collection of works by the same author (which we call an SWRB 
Set). 
 

	
  
Figure	
  51	
  -­	
  PDF	
  Resource	
  Sets	
  Window 

 
You can access these PDF Resource Sets by choosing the "PDF Resource Sets" 
option on the Main Menu. Clicking on the title of any of these sets will display a 
listing of all the works in the set. Though this listing cannot be modified or 
deleted, you can transfer these resources to a new Search Results window by 
clicking on the "Search Results View" button and use it as a basis for further 
editing and/or searching, as can be done with any Search Results listing. 
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Let’s now examine what functionality the PDF Resource Sets window contains. 
In the top section of the window is a group of 5 buttons.   
 

• “Display All”: will repopulate the window with all of the pre-defined PDF 
Resource Sets. This is useful after using the search feature of the window 
that usually results in a display of a subset of all PDF Resource Sets.  

• “Search Results View”: has the same functionality as in all other windows 
in which it appears.  It non-destructively converts the window into a 
Search Results window that can be edited and/or saved or used as the 
basis for further exploration of the KnowledgeBase.  

• “Search”: opens a dedicated search screen for the PDF Resource Sets. 
This allows the user to search within the 333  sets (1,715 PDF resources 
in total) by set title or by resource title among the resources contained in 
the sets.  

• “Close”: will close the current window. Multiple PDF Resource Sets 
windows may be open simultaneously.  

 
To the right of these buttons is the monitor icon for accessing tutorial videos on 
the PuritanDownloads.com website. To the right of that icon is a field that 
shows the number of sets contained in the window. The last interface element 
in this section is the by now familiar set of navigational buttons that can move 
the row marker forward and backward through the sets listing. 
 
The second section of the window has three columns. The first column displays 
the title of the set. Clicking on the title will open another PDF Resource Set 
window populated with all the resources in the set. The second column shows 
the number of resources in the set. The third column has a scrolling list of all 
the resources in the set. Clicking on the title of the resource will open its 
associated Resource Details Screen. 
 
This completes the tour of the PHD KnowledgeBase Application software. It is 
the fervent hope and prayer of Still Waters Revival Books that the functionality 
contained herein will, by the grace of our sovereign Lord, bless and facilitate 
your study of the thousands of great resources in the PHD collection for many 
years to come. 
 
 

56 
 

© Still Waters Revival Books, 2012 


	LAUNCHING THE PHD KNOWLEDGEBASE SOFTWARE
	MAIN MENU
	PHD KNOWLEDGEBASE SOFTWARE ON THE PHD-ODE
	PHD-ODE DOWNLOAD PROCESS

	THE SEARCH PROCESS
	SEARCH RESULTS WINDOW
	SEARCH PROCESS IN ACTION

	RESOURCE DETAILS WINDOW (PART 1)
	RESOURCE CATEGORY SIGNATURE (RCS)
	RESOURCE DETAILS WINDOW (PART 2)
	SAVED SEARCH RESULTS SET WINDOW
	SAVED SEARCH RESULTS SETS WINDOW
	SAVED SEARCH RESULTS SET LISTS WINDOW
	PDF RESOURCE SETS WINDOW



